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Lab Overview 

So far this semester, our lab activities have involved fixing “broken” PsychoPy 

experiment scripts by adding missing components. You’ve added stimuli components, such 

as Text and Images); you’ve also added the response components Keyboard and Mouse 

components. These stimuli and response components are the most concrete elements of what 

the subjects (i.e., you) experience during the experiment. You even have experience with the 

more abstract elements of experimentation: By inserting Loops into the flow of an 

experiment and by loading conditions files (*.xlsx or *.csv), you have specified the 

experimental manipulations to the stimuli. On the analytical end of the experiments, you 

have become proficient in running segments of R scripts, performing basic computations, and 

you even modified short segments of R scripts. 

The purpose of Lab 3 is to pull these tasks together into a simple experiment where 

you build the entire PsychoPy script, collect data, then perform individual and group analyses 

by assembling the basic data analysis elements R (import, reorganize, analyze, plot). Some 

parts of the experiment are, by necessity, highly specified (e.g., some components need exact 

names). Other parts of the experiment are don’t need to be so exact, so you have some 

freedom to customize your experiment.  

 Lab 3 will recreate a classic psychology experiment on the Stroop Effect. We will complete 

Lab 3 over the course of 2 weeks in three stages:  

Part 1: Define the Stroop Effect, build a script in PsychoPy to test it. 
Part 2: Collect data, make an R script to analyze your data, then analyze them. 
Part 3: Build a script to analyze group data; analyze group data. 

By the end of this lab, you should be able to: 

• Build	a	PsychoPy	experiment	from	scratch	

• Assemble	R	script	components	to	analyze	individual	and	group	data	

• Test	a	hypothesis	using	response	times	as	a	dependent	variable	
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LAB INSTRUCTIONS 

Introduction Section 

We’ll begin by performing a brief literature search to define the Stroop Effect, such 

as what stimuli are traditionally used, and how it’s measured. We will also compare/contrast 

a couple of the major online databases (Google Scholar & Web of Knowledge), each of 

which have strengths and weaknesses, depending on the purpose of your search. Very often, 

those new to research have inefficient search strategies, such starting with individual research 

articles, which provide minimal research context. In Figure 1, we recommend a search 

strategy that organizes different type of sources by scope (general to specific):  

 

Encyclopediae 

1.1 In a web browser of your choice, find the Wikipedia entry on the Stroop Effect  
	

1.2 Copy-paste the Wikipedia description of the Stroop Effect into the Introduction 
.Rmd file (in the Lab 3 folder), for later use. 
 

 

Encyclopediae

Undergraduate	Textbooks

Handbook	Chapters

Review	Articles

Dissertations

Meta-
Analyses
Research	
Articles
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Review Articles 

1.3 In a web browser of your choice, go to Google Scholar 
(https://scholar.google.com) 

1. Search	for:	“Stroop	Effect”	
2. The	top	hit	should	be:		

 
	

1.4 A PDF of the MacLeod (MacLeod, 1991) article is included in the 
Lab_3_Documentation folder. 
 

1.5 Read the first few paragraphs, STOP when you get to the Heading: “Stroop’s 
Classic Article”(~midway down the left column on page 164).  

1. What	was	the	phenomenon	that	was	so	interesting	to	these	authors?	
2. What	was	the	empirical	controversy?	
3. What	was	Stroop’s	contribution?	

Research Articles 

1.6 In a web browser of your choice, go to Web of Knowledge 
(webofknowledge.com). 

1. Using	the	search	fields,	search	for	Stroop’s	1935	article,	entitled	Studies	
of	interference	in	serial	verbal	reactions	(Stroop,	1935).	

For example: Author, Year Published 

 
1.7 A PDF of the Stroop (1935) research article is also included in the 

Lab_3_Documentation folder. 
 

1.8 In 1935, J. Ridley Stroop didn’t have computers to perform his experiments. 
In your own words, describe the methods in experiment 1: put your 
description in the Introduction.Rmd of your lab report template for later use. 
 

1.9 What was the result? Shown in Table I, and in prose on page 17. 
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Method Section 

Time to make our own experiment! We find that it goes quite fast if you work in teams of 

two, so pair up with your neighbor. 

2.1 In a classic Stroop Color-Word Task, what are the independent variables? 
Independent	Variable	1:	
Independent	Variable	2:	

2.2 In a classic Stroop Color-Word Task, what is the dependent variable? 
 

We’ll be making a variation of the classic experiment that includes the above 

variables, and measures response time (RT) one word at a time. Let’s begin by defining the 

experimental conditions in the conditions file, appropriately named conditions.xlsx. 

2.3 Open Lab 3 Tools > Stroop exp > conditions > conditions.xlsx 
1. Note	the	header	names	–	Do	not	change	these	names.	We	need	these	

names	later	in	the	R	scripts	that	analyze	the	data.	
	

text letterColor corrAns congruency 
    

 

2.4 The text column defines the words that our stimuli for the experiment.  
1. In	this	experiment,	we’ll	use	the	words	“red”,	“green”,	and	“blue”.	

	
2.5 The letterColor column defines the color of the words that appear on the screen. 

1. The	colors	we	will	use	are	red,	green,	and	blue.	
2. What	will	a	subject	see	for	row	2?	Row	10?	

	
2.6 Subjects will respond by pressing the left, down, and right arrow keys on the 

keyboard. Here are the word colors and the correct responses): 
 
letterColor corrAns 
red left 
green down 
blue right 

 

2.7 The corrAns and congruency columns are blank. Let’s fix that. 
 

2.8 In the corrAns column of the conditions file, add the correct response for each row 
of letterColor condition (as shown in Box 2.6).  

1. Only	left,	down,	or	right	(be	careful	not	to	have	a	blank	space)	
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2. All	lower	case,	no	extra	characters	
	

2.9 In the congruency column, add whether the condition is congruent or 
incongruent.  

1. If	the	word	and	the	letterColor	are	the	same,	then	it	is	a	congruent	
trial.		

2. If	the	word	and	the	letterColor	are	NOT	the	same,	then	it	is	an	
incongruent	trial.	
	

2.10 SAVE your changes. 
 
IMPORTANT: Check and recheck that your conditions.xlsx entries are accurate 
before continuing!!!! Make sure that you have not accidently put a blank space 
after a word you typed in a column. In computers “congruent “ is a different word 
than “congruent”: it makes a difference! 
 

Trial Routine (must be EXACT, as is described below) 
2.11 Open PsychoPy, and create a new experiment: File > New (⌘N) 

	
2.12 Save the experiment to Lab 3 Tools > Stroop exp as: Lab 3 Stroop.psyexp 

 
2.13 In the trial routine, add 2 components: 

1. A	Text	component	named	word.	
2. A	Keyboard	component	named	resp.	
3. Save.	

	
2.14 In the word component: 

1. We	want	the	word	to	show	up	half	a	second	after	the	start	of	the	
Routine,	and	not	disappear.	

2. We	want	the	text	twice	as	big.	
3. Save	your	work	

 
2.15 In the word component: 

1. Change	the	text	to	say	something	else	(classroom	appropriate)	
2. Change	the	color	of	the	text	(try	different	color	names)	
3. Try	out	different	combinations	of	settings	
4. Save	your	work	

	
2.16 Add a Loop around the trial routine, and name it trials (probably the default) 
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1. In	the	Conditions	field,	use	the	Browse	button	to	load	the	conditions.xlsx	
file	we	fixed	earlier.	

2. If	this	worked	properly,	it	should	read:	

	
3. Set	the	number	of	blocks	to	run	to	5	(nReps	in	the	trials	loop	settings)	
4. Save	your	work	

	
2.17 Next, add the variables that tell PsychoPy what text to display ($text), and what color 

to display that text ($letterColor). In the word component 
1. Add	the	following	variables:	

a. $text	
b. $letterColor	

2. HINT:	Where	is	the	most	logical	place	for	these	variable	names?	
3. IMPORTANT:	To	the	right	of	the	fields	you	added	the	variables	($),	

change	the	dropdown	boxes	to	“set	every	repeat”.	If	your	script	doesn’t	
work	properly	or	crashes	during	test,	this	is	the	most	likely	culprit!	

4. Save	your	work	and	test	the	program	

PROTIP: Once it becomes obvious to you that a change you made is working 
properly (or not), you can end the test with the “Escape” key. 

	
2.18 Time to adjust the settings for the Keyboard component you named resp: 

1. We	don’t	want	subjects	to	respond	before	they	see	the	text	stimuli.	
2. We	want	to	limit	subjects’	responses	to	the	appropriate	arrow	keys	

(left,	down,	right)	
3. We	want	PsychoPy	to	store	whether	a	response	was	correct	or	not,	

(HINT:	so	we	need	to	tell	PsychoPy	what	the	correct	answers	are)	
4. Save,	test.	

	
2.19 At this point, you should probably check to see if PsychoPy is properly storing 

responses. 
1. Open	the	most	recent	CSV	file	in	the	“data”	folder	(Remember,	the	file	

name	has	a	timestamp).	
2. In	the	resp.corr	column	(1=correct,	0=incorrect)	
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Practice Routine (must be EXACT) 
2.20 Once you are certain that the trial routine is working properly, we need to add 

a practice routine before the trial routine so subjects can get used to using the 
arrow keys to respond. 

1. Name	the	routine	“practice”,	and	its	Loop	“p_trials”	
2. The	practice	routine	is	identical	to	the	trial	routine,	except	that		

a. The	text	and	keyboard	components	should	have	different	names	
(e.g.,	word2,	resp2)	

b. The	number	of	blocks	=	2	(nReps	in	the	Loop	settings).	
3. Save,	test.	

	
 

So far, we’ve created the core of our experiment, now we need to add routines that 

include on-screen instructions for subjects when taking the experiment. Each of these 

Routines need only 2 components: a text and a keyboard component. The text will show a 

message to the subject, and the keyboard component will advance the experiment by ending 

the routine. The names of these routines & components do not really matter, but give the 

routines names that are meaningful to you. The default component names work just fine. 

Instructions (can be flexible) 
2.21 Add 3 of these instructions/message routines to the experiment 

1. Add	a	routine	before	the	practice	routine	that	welcomes	the	subject	
and	tells	them	the	task	instructions.	

2. Add	a	routine	after	the	practice	routine	and	the	trial	routine	that	tells	
the	subject	that	the	real	experiment	is	about	to	begin.	

3. Add	a	routine	after	the	trial	routine	that	thanks	the	subject	for	taking	
your	experiment.	

a. For	this	final	routine,	you	can	omit	the	keyboard	component		
and	set	a	duration	for	the	text	component,	(e.g.,	4.0s)	which	
would	automatically	end	the	experiment	after	a	few	seconds.	

4. Save,	test.	
2.22 Change the settings of your text components until they look the way you want.  

 

Save your work and ZIP your folder 
2.23 Once your experiment works properly and looks professional, now is the time to 

SAVE the experiment for Part 2, running the experiment. 
1. In	the	data	folder,	delete	all	the	files	that	were	generated	each	time	you	

tested	your	script	(i.e.,	empty	the	data	folder).	
2. Your	experiment	folder	should	look	something	like	this:	
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3. Compress	the	experiment	folder	to	make	a	ZIP	file	that	is	easier	to	save.	

a. Right-click	the	folder	you	want	to	compress,	and	select	
Compress	“folder	name”	

 
4. Save	this	ZIP	file	using	whatever	method	works	best	for	you	

(Flashdrive,	GoogleDrive,	Dropbox,	etc.)	
5. Share	the	finished	program	zip	file	with	your	partner,	if	you	worked	as	

a	team.	
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Psychology of Perception 

Psychology 4165, Spring 2017 

Laboratory 3 (Part 2): 

Stroop Word-Color Task 

 
 

 
 

From Stroop (1935) 

INTERFERENCE IN SERIAL VERBAL REACTIONS 651

difference, the reliability of the difference, and the difference
divided by the mean time for the naming color test.

The comparison of the results for the whole group on the
NC and NCWd test given in the bottom line of the table in-
dicates the strength of the inteference of the habit of calling
words upon the activity of naming colors. The mean time
for 100 responses is increased from 63.3 seconds to 110.3
seconds or an increase of 74 percent. (The medians on the
two tests are 61.9 and 110.4 seconds respectively.) The
standard deviation is increased in approximately the same
ratio from 10.8 to 18.8. The coefficient of variability remains
the same to the third decimal place {aim = .171). The
difference between means may be better evaluated when
expressed in terms of the variability of the group. The dif-
ference of 47 seconds is 2.5 standard deviation units in terms
of the NCWd test or 4.35 standard deviation units on the NC
test. The former shows that 99 percent of the group on the
NCWd test was above the mean on the NC test (took more
time); and the latter shows that the group as scored on the
NC test was well below the mean on the NCWd test. These
results are shown graphically in Fig. 1 where histograms and

SO *0 SO 6O 70 00 90 JOO ZM J3O JiO J6O

44
35
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to
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Fie. I. Showing the effect of interference on naming colors. No interference ( i ) ;
interference (2).

normal curves (obtained by the Gaussian formula) of the two
sets of data are superimposed. The small area in which the
curves overlap and the 74 percent increase in the mean time
for naming colors caused by the presence of word stimuli
show the marked interference effect of the habitual response
of calling words.
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Lab Overview 

Previously, in Perception Lab: 

The purpose of Lab 3 is to pull these tasks together into a simple experiment where you 
build the entire PsychoPy script, collect data, then perform individual and group analyses 
by assembling the basic data analysis elements R (import, re-organize, analyze, plot). 

By the end of this lab, you should be able to: 
• Build	a	PsychoPy	experiment	from	scratch	
• Assemble	R	script	components	to	analyze	individual	and	group	data	
• Test	a	hypothesis	from	response	times	

Part 1: Define the Stroop Effect, build a script in PsychoPy to test it. 
Part 2: Collect data, build a script in R to analyze individual data, analyze individual data. 
Part 3: Build a script to analyze group data, analyze group data. 

 
In Part 1 you built an experiment in PsychoPy to demonstrate the so-called “Stroop-

Effect,” where naming the color of color words tends to be faster when the word and color 

are congruent (semantic facilitation), and slower when the word and color are incongruent 

(semantic interference). Now you will use your own experiment to collect your responses, 

and use R to analyze those responses. You have already had extensive experience analyzing 

data with R, including: 

1. Running	scripts.	
2. Storing	data	in	R	objects:	mydata <- c(1,2,3,4,5)	
3. Working	with	dataframes: df <- read.csv(“filename”)	
4. Performing	basic	computation:	mean(), sd()	
5. Transforming	data:	qnorm(), pnorm(), log10()	
6. Fitting	linear	models:	lm(), lmer()	
7. Bootstrap	analysis:	bootES()	
8. Visualizing	data:	plot()	
9. Using	functions:	function()	

	

This part of the lab will have 4 phases: (a) preparation for data collection, (b) data collection 
and upload, (c) individual data analysis, (d) group data analysis next week 
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Lab Instructions 

Preparation for data collection 

“Measure twice, cut once.” said every grandpa, ever. 

We need to double check a couple things before we collect data so that your analysis 

goes more smoothly. Remember: settings are spelling & case-sensitive! 

3.1 Run your experiment on your computer. 
1. Run	the	experiment	on	your	own	computer,	even	if	you	wrote	the	

script	with	a	partner.	
2. Verify	that	the	following	files	and	folders	are	present,	and	in	this	basic	

configuration	(your	filenames	may	vary,	but	the	file	structure	should	
not!):	

 
3.2 Open the conditions file (*.xlsx), verify that it has the changes you made last week 

1. You	added	values	to	the	columns:	corrAns,	and	congruency	
2. Verify	that	these	values	are	correct	for	each	row!!!	

a. Are	the	responses	in	the	corrAns	column	(left,	down,	right)	
correct,	given	the	values	in	the	letterColor	column	(red,	green,	
blue)?	

b. Are	the	values	in	the	congruency	column	correct,	given	both	the	
values	in	the	text	and	letter	Color	column?	(same=congruent,	
not	same=incongruent)	
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3. After	you’ve	inspected	your	own	file	and	made	any	necessary	changes,	
have	a	neighbor	triple-check	your	conditions	file,	and	you	check	their	
conditions	file.	

4. Save,	close	Excel.	
3.3 Open PsychoPy, then open (⌘O) your experiment file (*.psyexp). 

1. Remember!!!	Open	PsychoPy	first,	then	open	the	.psyexp	file	using	
either:	

a. The	menu	(File	>	Open).	
b. The	keyboard	shortcut	(⌘O).	
c. Dragging	the	.psyexp	file	from	the	folder	to	the	PsychoPy	icon.	

	
3.4 Verify that your experiment script still has all its parts: 

1. A	trial	routine	
2. A	practice	routine	that	is	similar	to	the	trial	routine	for	your	subjects	to	

get	used	to	the	buttons.	
3. Three	routines	containing	text	&	keyboard	components,	that	provide:	

(a)	welcome	&	instructions,	(b)	a	warning	that	the	real	trials	are	
coming	up,	and	(c)	a	warm	heartfelt	thank	you	at	the	end	of	the	
experiment.	

4. Save.	
	

3.5 Verify the settings in each of the components. Most settings don’t matter much, but 
do make sure that: 

1. trial	routine:		
a. start	times	are	correct	
b. durations	are	blank	
c. text	component	is	named	“word”		
d. keyboard	component	is	named	“resp”	
e. variables	are	preceded	with	a	“$”	($letterColor,	$text,	$corrAns)	

2. practice	routine:	
a. same	as	trial	routine,	except	the	names	of	text	and	keyboard	

components	are	different.		
3. Save.	

	
3.6 In the trials Loop (the one around the trial routine): 

1. Using	the	“Browse…”	button,	reload	the	conditions.xlsx	file	(this	is	a	
preemptive	step,	intended	to	prevent	a	script	crash)	

2. set	nReps	to	10	
3. Save.	

	
3.7 In the p_trials loop (the one around the practice routine): 

1. Using	the	“Browse…”	button,	reload	the	conditions.xlsx	file	(this	is	a	
preemptive	step,	intended	to	prevent	a	script	crash)	
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2. set	nReps	to	1	
3. Save.	

	
3.8 Briefly test your script on yourself. 

1. Run	the	script	(⌘R),	making	a	mix	of	correct	and	incorrect	responses.	
2. You	don’t	need	to	test	the	entire	experiment,	but	do	test	at	least	

through	the	practice	trials	and	a	few	of	the	actual	trials.	
3. Press	escape	to	end	the	script.	

a. Did	the	experiment	work	&	look	the	way	it	is	supposed	to?	If	
not,	make	necessary	changes.	

4. Open	the	csv	data	file,	and	verify	that	the	responses	were	recorded,	the	
responses	were	scored	correctly	(resp.corr	column:	1=correct,	
0=incorrect).	If	not,	check	the	settings	in	keyboard	object	“resp”	

5. Save.	
	

Data collection 

3.9 Run the experiment to collect responses for yourself 
 

3.10 Inspect your csv data file, verify the data by opening it in Excel. 
 

3.11 UPLOAD YOUR CSV FILE TO CANVAS  
 

Individual Data Analysis 

“There's something that happens with the collection of a large amount of data when it's 
dumped into an Excel spreadsheet or put into a pie chart. You run the risk of completely 

missing what it's about.” Aaron Koblin (digital media artist). 

 Time to make meaning from your personal pile of responses. Before you start, you 

need to make an analysis plan. The most common mistake people can make when analyzing 

data is also the worst: starting the analysis without a plan. Let’s avoid this frustrating and 

time-consuming error by making an analysis plan! We need to explicitly state (a) the 

variables in our dataset (independent, dependent); (b) how these data tell us anything about 

our phenomenon of interest, in this case color-word interference effects.  

Variables 

 Every experiment has at least 2 types of variables:  
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Independent variable (IV): In experimental settings, the stimulus condition 
whose values are varied by the experimenter independently of any other 
variable in the situation (American Psychological Association., 2010). (in 
non-experimental studies, called predictor variable) 
 
Dependent variable (DV): In an experimental setting, any variable whose 
values are the results of changes in one or more independent variables 
(American Psychological Association., 2010). (sometimes called 
measurement variable or outcome variable) 
 
Check out the definitions at APA, 2015. 

 

Not all IVs are created equal, and it sometimes can get pretty confusing figuring out 

which variable is important to our research questions. Here are a couple terms to help us 

think about independent variables in an experiment:  

Stimuli-level variable: The way(s) that stimuli are systematically varied 
that allow measurement by varied responses. 

 
Hypothesis-level variable: The variable(s) in an experiment that allow 
the testing of a hypothesis. 

In perception research, hypothesis-level variables are the contrasting conditions used 

to test a hypothesis. The levels in a hypothesis-level variable tend to be few in number (2 or 3 

levels), but the differences between those levels tend to be large. On the other hand, stimuli-

level variables tend to have many levels, and those differences also tend to be small. While 

variability of stimuli is important to any hypothesis, the results of a stimuli-level variable 

tend to be uninformative to the bigger picture of the experiment.  

 

3.13 
In our experiment, what were the independent variables (IV)? (HINT: 3) 
>>> 
 

3.14 Of these IVs, which was/were so-called stimuli-variable(s) ? 
>>> 
 

3.15 Of these IVs, which was/were the so-called hypothesis-variable(s)? 
>>> 
 

3.16 What was/were the dependent variable(s) (DV) in this experiment? (HINT: 2) 
>>> 
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Expected Results 

We’ve already seen the tilde math symbol ( ~ ) used in R formulae to represent 

“dependent on.” For example: 

alertness ~ coffee_consumption    (1) 

According to Formula 1, mental alertness is dependent on an amount of coffee 

consumed (a testable hypothesis). Can you think up other silly examples that use the tilde 

(~)? 

3.17 In our experiment, given the hypothesis-level variable and the dependent variable, 
use the tilde symbol to represent the relationship we’re testing. 
>>> 
 

3.18 Based on what you know about the Stroop Effect, what is the expected result of 
testing the above relationship?  
>>> 
 

Taking the time to explicitly (a) identify the function of variables, (b) define a 

mathematical relationship between those variables, and (c) the result of testing that 

relationship saves you time in the long run, but also ensures you understand what it is that 

your doing at every step during the analysis. For most people this type of reasoning takes 

time to develop, but is crucial to the research process. Time to compute some results! So… 

what do you want to compute? 

Switch to RStudio 

After you have uploaded your .csv data file to Canvas, move a copy of the file to the 

my_lab_3.0_additional_files folder in the Lab_3_Report_Folder_2018_Spring Broken. 

Double click on the my_lab_3.5_Individual_Results broken.Rmd file to launch RStudio. Fix 

the things in the markdown file that need fixing and carry out your analysis on your 

individual data. Once you get the file to work properly (choose ‘Run All’ from the Run tab in 

RStudio) you can add your own text with your own descriptions and your own conclusions 

about your individual data. Once `Run All` works you can knit the file to a pdf to make sure 
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that it will produce a pdf file but you will not be able to knit the whole report until you get 

the group data next week and get that analysis working properly. 
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